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Chapter 1 

Overview of BPM Portal

This guide is intended for administrators, who, through BPM portal, can interact with BPM 
applications.

Introduction to BPM Portal     2
BPM is a Web-based user interface. Administrators can interact with BPM applications through 
BPM Portal.

Logging in to BPM Portal     2
Log in as administrators. 

BPM Portal Keyboard Shortcuts     3
BPM Portal provides a list of keyboard shortcuts to access various menus and menu options.
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Introduction to BPM Portal 

BPM Portal is a Web-based user interface through which you can interact with BPM applications.

When you log in to BPM Portal, it displays the Home tab for all users, irrespective of user type and 
user permissions. Task performers can display and modify tasks assigned to them, and manage 
their preferences. 

The Management tab lets managers query, report, and control processes and resources.

The Administration tab is for administrators to modify configuration parameters controlling BPM 
operations, manage components, and install or uninstall applications. 

Fig. 1.1
BPM Portal

Logging in to BPM Portal

To access BPM Portal:

1 Start the Login page.

2 Log in as an administrator.

• For Username, enter: ebms 

• For Password, enter: ebms

• For QAD Domain, choose one option from the drop-down list. If omitted, it defaults to the 
QAD (system) domain. The value only matters when accessing group (role) memberships 
in User Management of the portal, so you can typically ignore it.
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Fig. 1.2
Logging in to BPM Portal

3 Click Login.

BPM Portal Keyboard Shortcuts

BPM Portal provides the following keyboard shortcuts to access various menus and menu options.

Table 1.1  
BPM Portal Keyboard Shortcuts

Tab Keys Menu or Menu Option

Home Ctrl+Shift+T My Tasks

Ctrl+Shift+M My Instances

Ctrl+Shift+S Applications

Ctrl+Shift+D Dashboard

Ctrl+Shift+O Profile

Ctrl+Shift+F Preferences|Filters

Management CTRL+SHIFT+I Overview|Instances

CTRL+SHIFT+A Overview|Applications

CTRL+SHIFT+R Reports|My Resports 

CTRL+SHIFT+N Instance Manager|Instances

CTRL+SHIFT+K Instance Manager|Tasks

CTRL+SHIFT+W Instance Manager|Worksteps

CTRL+SHIFT+C Balanced Scorecard|Console

Administration CTRL+SHIFT+V System|Log Viewer

CTRL+SHIFT+U User Management|Groups

CTRL+SHIFT+G User Management|Groups

CTRL+SHIFT+Q User Management|Queues

CTRL+SHIFT+P User Management|Permissions

CTRL+SHIFT+E User Management|Delegate Settings

CTRL+SHIFT+L Applications|BizLogic

CTRL+SHIFT+Z Applications|Bizsolo
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Chapter 2

Using QAD BPM Portal 

Working with My Instances on the Home Tab     6
You can use Home|My Instances to view, check status of, and remove system background 
processes.

Searching for Process Instances on the Management Tab     11
You can use Management|Overview|Instances to search for all process instances.

Working with My Reports on the Management Tab     12
You can use Management|My Reports to create your own reports containing any data from the 
BPM database, and displayed with custom layouts. 

Working with Instances on the Management Tab     28
You can use Management|Instance Manager|Instances to search for all process instances for a 
particular BizLogic application label. You can also view dataslot values and remove process 
instances from this page. 

Restarting BizLogic or BizPulse     30
You can use Administration|System|Status to stop and restart BizLogic or BizPulse.

Using the Configuration Interface     31
You can use the Configuration interface to change log levels for BPM components, and configure 
BizLogic and the email server.

Viewing Log Files on the Administration Tab     34
You can use Administration|System|Log Viewer to track the status and error messages for each 
component.

Defining Business Calendars     35
You can define business calendars using Business Calendar and assign them to specific users or 
groups.

Managing Users on the Administration Tab     37
You can use Administration|Users to search for all users and maintain user properties specific to 
BPM. Also you can use the tab to grant BPM data access permissions and portal usage permissions 
to selected QAD users. 

Managing Groups on the Administration Tab     40
You can use Administration|Groups to search for all groups and maintain group properties specific 
to BPM. Also you can use the tab to grant BPM data access permissions and portal usage 
permissions to selected QAD groups.
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Working with My Instances on the Home Tab

As an administrator, you can view, check status of, and remove system background processes by 
using My Instances on the Home tab.

Viewing System Background Processes 

On the Home tab, click My Instances, and you can see that the My Instances page includes the 
following processes:

• Daily User Tasks Email Notification

• OpenEdgeDDLOperationHandler

• QdocEventHandler

Fig. 2.1
My Instances Page
 

You can check the process status in two modes: either in a tabular view or in a flow view. Both 
these views represent the same data and allow you to perform the same operations.

Checking Status in Tabular View 

To check status of process in tabular view, in the My Instances list page, click the PSV Tabular 
View icon.

Fig. 2.2
Clicking Tabular View Icon

Alternatively, in the flow view of the Process Status Viewer page shown in Figure 2.5 on page 8, 
click the Tabular View link. 

On the Process Status View page, you can see work steps in tabular format. The name of the 
process instance is displayed below the link trail. 
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Fig. 2.3
Process Status View-Tabular View

The Tabular View displays the Start work step as the first work step at the top of the list. Then the 
completed work steps in order of the completion time, the activated work steps, and suspended 
work steps sorted by activation time follow successively. The End work step is displayed as the 
last work step.

The work step status is marked in the table, using color coding. Each color indicates a different 
status of the work step, as explained in the following table.

Table 2.1  
Work Step Color Coding 

Work Step Color Status

Orange Activated work step

Green Completed work step

Gray Inactive work step

Blue Skipped work step

Red Suspended work step

Dark Green Monitoring work step in wait state

Checking Status in Flow View

To check the status of a process in the flow view, in the My Instances List page, click the PSV 
Flow View icon. 

Fig. 2.4
Clicking Flow View Icon

Alternatively, in the tabular view of the Process Status Viewer page shown in Figure 2.3 on page 7, 
click the Chart View link. 

The following figure shows an example of the process flow view page. The process instance name 
is displayed below the link trail.
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Fig. 2.5
Process Status View-Flow View

Fixing Issues by Running OpenEdgeDDLOperationHandler

OpenEdgeDDLOperationHandler is a BizLogic application in BPM that runs in the background all 
the time. It starts automatically on startup of the BPM server. It works around a limitation in the 
OpenEdge database that prevents tables from being dropped from the database using SQL 
connections while the database is online. 

Sometimes, the instances you can see in the My Instances page or Processes browses in the .NET 
UI do not appear on the Instance Manager pages of BPM Portal. So when you select processes to 
delegate to another BPM user on the Delegate My Tasks screen in the .NET UI, you find that 
applications in the drop-down selection list are incomplete. A similar issue arises when you 
attempt to delegate processes to another BPM user from the Delegation Settings page of BPM 
Portal.

The root cause for these issues is that your business process with the application name 
OpenEdgeDDLOperationHandler is suspended or is not running. Whenever a process is 
uninstalled or reinstalled from BPM, BPM dynamically generates database table schemas to 
support the new process, and deletes the old tables associated with the process being uninstalled. 
Because the OpenEdge database does not allow the obsoleted tables to be dropped on the fly 
through SQL requests, the tables are not deleted immediately but only marked for deletion. The 
OpenEdgeDDLOperationHandler then deletes all the tables marked for deletion asynchronously, 
checking for pending deletions every few minutes. Because this process runs periodically in the 
background under normal conditions, there is a lag of several minutes. 

If the OpenEdgeDDLOperationHandler process is stopped or suspended for some reason, then 
deletion of obsoleted database tables is not timely. This delay in turn causes two components 
within the BPM server, BizLogic and BizStore, to become out-of-sync. The result is that some of 
the SQL joins used to access BPM database records from some BPM portal pages cannot succeed. 
The failure leads to the omission of process instance or application records from various displays. 
The records not displayed depend on which database tables have been marked for deletion but not 
yet deleted, and the length of time the OpenEdgeDDLOperationHandler process has not been 
running.
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To resolve the issue, go through the following steps:

1 Log in to BPM Portal as the administrator user and go to Home|My Instances. Find the 
OpenEdgeDDLOperationHandler process.

2 If OpenEdgeDDLOperationHandler is not displayed, skip to step 5. Otherwise, select the PSV 
Tabular View icon in the Details column to display the Tabular view of the process.

3 If the Status column for work step Activity 2 is ActivationWait inside a gray box, skip to the 
end of this procedure, as the process is running normally. 

Fig. 2.6
ActivationWait Status

If the Status is Suspended inside a red box, go back to the My Instances page.

Fig. 2.7
ActivationWait Status

4 On the My Instances page, check the box in the first column of the 
OpenEdgeDDLOperationHandler row. Click Remove to delete the process.
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Fig. 2.8
Remove the OpenEdgeDDLOperationHandler Process

5 Go to Home|Applications, and locate the application OeDDLOperations in the list.

Fig. 2.9
Locating OeDDLOperations

6 Select the link in the Application column, and Click Create to launch an instance of 
OpenEdgeDDLOperationHandler.

Fig. 2.10
Create the OpenEdgeDDLOperationHandler Process Instance

7 Go back to Home|My Instances, and confirm that an instance of 
OpenEdgeDDLOperationHandler is now running.

8 Select the PSV Tabular View icon in the Details column to display the Tabular view of the 
process. Confirm that the Status column for work step Activity 2 is now ActivationWait inside 
a gray box, indicating that the process is running normally. See Figure 2.6 on page 9.
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Removing Process Instances

Compared with normal users who can remove their own process instances from the My Instances 
page, administrators can remove system background processes from the My Instances page.

To remove instances:

1 From the My Instances page, select the instances you want to remove.

2 Click Remove.

Note   Even for managers who want to remove process instances, it is much easier to use My 
instances on the Home tab than to use Instance Manager on the Management tab.

Searching for Process Instances on the Management Tab

You can also search for process instances from the Management tab by completing the following 
steps:

1 On the Management tab, click Overview|Instances to display the Instances overview page. 

The Instances Overview page displays information about the application instances you are 
currently using. By default, it displays all instances and the following information about each 
instance:

Table 2.2  
Instance Overview Information

Column Description

Application A unique identifier for the application instance.

Instance The name of the process instance.

Status The status of the filtered instance.

Creator Click the PSV Tabular View icon in this column to display the tabular view of the process instance. 
Click the PSV Flow View icon in this column to display the process instance flowchart at the point 
of the active task. Click the Audit History icon in this column to display the audit history of the 
process instance.

Priority Priority level that the user determines when initiating the process instance. It can be Low, Medium, 
High, or Critical.

Estimated Duration Estimated duration to complete the process instance, as determined by the application developer.

Start Date The date the process instance was initiated.

Due Date The date by when the process instance ought to be completed that the application developer 
determines.

End Date The date on which the process instance was completed.

2 Use the search features in the filter bar to specify the process instances you want to search.
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Fig. 2.11
Searching for Process Instances

• Select a BPM application from the Application drop-down list in the upper left of the filter 
bar. Then you can see data on all instances for the selected application in the workspace.

• Select an option from the Status drop-down list. Options include: All, Active, Completed, 
Removed, and Suspended. Active indicates that the instance is active and can be run. 
Suspended indicates that the instance is temporarily stopped until the Resume option is 
selected.

• Select an option from the Duration drop-down list. Options include: Hours, Weeks, Days, 
and Business Days. Use this search criterion only for instances with a Completed status.

• Specify a Creator if applicable. Click the Select Creator icon to open the User List, from 
which you can select a valid Application user.

• Select an option from the Priority drop-down list. Options include: All, Critical, High, 
Medium, and Low.

• Select an option from the Start Date drop-down list. Options include: Today or Yesterday, 
This Week or Last Week, This Month or Last Month, and so on. To define a more specific 
time range, click the Select Date icon and choose a start date and end date from the pop-up 
calendars.

3 After you have finished entering filter criteria, click Search to locate the specified instances.

Note   You can retrieve and check status of process instances from the Instances overview page, 
but you cannot remove instances from the page.

Working with My Reports on the Management Tab

BPM Portal allows you to define simple reports on-the-fly to retrieve process instance or task 
information with simple filtering. But those reports have the following limitations:

• Can only include process instance or task information.

• Single-table report only, with no SQL joins.

• No totals, counts, control breaks, or calculated fields.

• Simple fixed layout.
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The BPM database contains detailed information on the state of all business process instances, 
their templates, and event-level details. When you use JasperReports, an open-source Java 
reporting framework, you can create detailed reports containing any data from the BPM database, 
and in custom layouts.

Note   This manual covers only a little of the JasperReports functionality. For more information, 
refer to Jasper documentation.

Installing and Configuring JasperAssistant Plug-in in BPM Studio

You can use Jasper Assistant plug-in with BPM Studio to create your Jasper reports. 

Note   Although the JasperAssistant Eclipse plug-in is not free, you can use the stand-alone 
iReport tool from Jasper, which is free, to design the same reports. If you use iReport, the details of 
implementing reports are different from what is described here.

Complete the following steps to install JasperAssistant:

1 Launch BPM Studio.

2 Click Help and select Install New Software.

Fig. 2.12
Installing New Software

3 Click the Add button to display the Add Repository window. 

In the Name box, enter the Jasper Assistant update site.

In the Location box, enter http://www.jasperassistant.com/updates/3.x/.

Click OK.
                                                 



14     Administration Guide — QAD BPM
Fig. 2.13
Entering Data in Add Repository

4 Check the Jasper Assistant line item.

5 Click Next, accept the license, and Click Finish.

6 Restart BPM Studio.

After installing the Jasper Assistant plug-in, configure the preferences and data source:

1 From the Window menu, select Preferences|JasperAssistant|Data Sources.

Fig. 2.14
Selecting Data Sources

2 Click New and select Database Data Source in the Data Source Type drop-down list.
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Fig. 2.15
Selecting Database Data Source

3 Click OK to display the New Database Data Source window. Enter data in the text boxes. 
Make sure that you fill the corresponding text boxes with the following data.

• Driver: com.ddtek.jdbc.openedge.OpenEdgeDriver

• URL: jdbc:datadirect:openedge://<hostname>:<DB SQL port>; DatabaseName=<BPM 
DB name>

• Username-Password: BPM database DBA credentials set during BPM installation, often 
sbm

• JAR file 1: <DLC home>/java/openedge.jar

4 Click Test and confirm that the connection is successful.

5 From the Window menu, select Open Perspective|Other|JasperAssistant to switch Studio to 
JasperAssistant perspective.

Note   This step is optional. It is for your convenience.

6 From the File menu, select New|Project to create a Java project to develop reports. Select Java 
Project wizard from the New Project dialog window and click Next. Then enter information in 
the New Java Project dialog window. The following figure shows an example of it.
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Fig. 2.16
Selecting Database Data Source

Creating and Opening Reports 

To create reports using New Report Wizard:

1 From the File menu, select New|Report.

The New Report Wizard dialog window appears.

2 Select the parent project folder and then enter the report name in the File Name text box and 
click Next.
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Fig. 2.17
Creating a New Report

3 Select a BPM database as the data source and click Next.
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Fig. 2.18
Selecting a Data Source 

4 Skip the SQL entry for now and click Finish.

Note   JasperReports allows creating reports from templates, but this guide does not cover the 
feature.

5 Double-click the report source file (with .jrxml extension) to open the existing report.

Fig. 2.19
Opening Existing Report
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Designing Jasper Reports

Report Layout

Reports are structured visually as horizontal bands containing data in a fixed vertical stack. 
Designers can decide the content and visual layout of each band with a specific level of details. All 
bands are optional and designers can have their discretionary choices according to the target 
report. 

Here is a list of the bands typically used for most reports, in the order they are stacked vertically in 
the report layout. 

• Title: Appears once at the beginning of the report. 

• Page Header: Appears at the beginning of each page.

• Column Header: Appears at the beginning of each column, for multi-column reports.

• Group Header: Printed above the detail section each time the associated group’s grouping 
expression changes in value. If multiple groups are defined, their headers appear in the order 
in which the groups are defined.

• Detail: Printed for each line of data retrieved from the report’s data source.

• Group Footer: Printed below the detail section just before the associated group’s grouping 
expression changes in value. If multiple groups are defined, their footers appear in the order in 
which the groups are defined. Always printed after the last detail line.

• Column Footer: Appears at the bottom of each column, for multi-column reports.

• Page Footer: Appears at the bottom of each page.

• Last Page Footer: Replaces the regular page footer on the last page of the report.

• Summary: Appears once at the end of the report.

The following figure shows an example of the report layout.

Fig. 2.20
Report Layout

Expression Syntax

Expressions are critical in JasperReports, as they are used to calculate variables as well as define 
how to categorize and partition the reported data by group. Expression syntax is based on standard 
Java, enhanced with Jasper-specific characters and functions.
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Jasper-specific functions are as follows.

• $F{<field name>}: Reference a field by name.

• $V{<variable name>}: Reference a variable by name.

• $P{<parameter name>}: Reference a parameter by name; not supported with BPM.

• $P!{<parameter name>}: Reference a parameter by name within an SQL query string only; 
not supported with BPM.

• $R{<resource key name>}: Reference a string literal by key name within the resource bundle 
associated with the report; useful for language translation.

Example   

• new Integer(Math.max($V{Price1}, $V{Price2}))

• (new SimpleDateFormat(“dd/MM/yyyy”)).format($F{OrderDate})

• $F{SpecialOffer}.booleanValue()? $F{SpecialPrice}: $F{Price}

Fields, Variables and Parameters

The data elements making up the contents of a report are fields, variables, or parameters, in 
addition to literal text and graphical elements.

• Fields: Data elements retrieved directly from the data source, typically from database tables.

• Variables: Values calculated using expressions and built-in calculation functions, typically 
based on the fields retrieved from the data source or parameter values.

Variables have the following properties that specify how they are calculated.

• Calculation: Can be Count, Distinct Count, Sum, Average, Lowest, Highest, Standard 
Deviation, Variance, First, System, or Nothing.

• Expression: Specifies a calculation formula referencing fields, parameters, and other 
variables as appropriate.

• Reset Group and Type: If Reset Type is Group, then Reset Group references the group 
whose breaks specify when the variable’s value is reset.

• Value Type: Java class defining the data type (Example: java.lang.Integer, 
java.lang.String, java.lang.Long)

• Parameters: Values that the requester of the report specifies at run time, just before the report is 
generated. However, the BPM-JasperReports integration does not support parameters, so they 
are not covered further in this document.

Groups

A group specifies how designers ought to group or partition the detailed report contents based on 
common values. It is the same as what is called Control Break in many other report writers. The 
most typical use case is the grouping of data based on the values of some non-key fields in the 
database. A report can and typically does include multiple groups, used to provide several levels of 
detail with counts or other calculated summaries for each group.

Example   If you want to group process instances on the report by their process creator within the 
application name, define both Application Name and Process Creator as groups.
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To define a group, use a grouping expression based on fields retrieved from the data source using 
the same syntax described in “Expression Syntax” on page 19. Typically, it is a field or variable 
name that is used to partition the report details into useful sections.

Example   To group the BPM process instances by the Application Name field called 
APP_NAME, the grouping expression is $F{APP_NAME}.

Defining BPM Database Query and Fields

The first step in designing a report is typically defining an SQL query that retrieves the data 
displayed on the report or used in its calculations.

• Analyze the BPM database schema using an SQL-based query tool (Example: DbVisualizer or 
SQuirrel SQL) to find the location of the required data and relevant keys.

• Write the SELECT statement, including JOIN, WHERE, and ORDER BY clauses.

To specify the query:

1 Open the report and go to the Outline view in Studio.

2 Select the top-level report node.

3 In the Properties view, select the drill-down button for the Query property.

4 Enter the SQL statement into the dialog box and Click OK.

Fig. 2.21
Specifying the Query

To specify the database fields retrieved from the query in the report:

1 Open the report and go to the Outline view in Studio.

2 Select the top-level report node.

3 Right-click to the Field Wizard, and select the data source.

4 Alter the SQL query, if necessary.

5 Select the desired fields using the dialog box and Click Finish.
                                                 



22     Administration Guide — QAD BPM
Fig. 2.22
Selecting the Fields

Defining Groups and Variables

Besides the fields making up most of the detailed line items of the report, you are also required to 
define variables and groups. Variables include all counts, totals, and other statistics calculated at 
the group or report level, in addition to calculated fields. Typically you define the variables and 
groups together, because many variables are designed to summarize data at the group level for 
display in group headers or footers.

To define a group:

1 Open the report and go to the Outline view in BPM Studio.

2 Expand the top-level report node and select the Groups node.

Fig. 2.23
Selecting the Groups Node
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3 Right-click to the Add Group command.

4 Fill in the Name, Expression, and other properties in the Properties view.

Fig. 2.24
Filling in Properties 

To define each variable:

1 Open the report and go to the Outline view in Studio.

2 Expand the top-level report node and select the Variables node.

3 Right-click to the Add Variable command.

4 Fill in the Name, Expression, Initial Value Expression, and Value Type in the Properties view.

5 Select the Reset Type and, if relevant, the Reset Group value to associate the variable with a 
group level.

Laying Out Reports and Preview

To lay out a report:

1 Design each band that is to appear on the report, including headers, footers, and details.

2 Drag desired report display objects from the Palette into the desired bands.
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Fig. 2.25
Dragging Report Display Objects from the Palette

• Use text fields for most data elements, with Expression property referencing fields or variables 
and any calculations.

• Set Evaluation Group and Evaluation Time properties to correct values reflecting timing of 
calculations.

• Use text fields with literal values to define field labels.

Note   Arrangement of data elements and literals within each band is entirely flexible and user-
defined.

3 Design and refine layout details.

Note   Use frames to define areas with special colors or other attributes to contain related 
fields with the same display characteristics.
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Fig. 2.26
Using the Frame

To preview report:

1 Select Preview tab.

2 Select data source, normally BPM database.

3 Fix errors and rework implementation as required.

Deploying Reports

When a report is correct and complete, make sure that you deploy it manually to the BPM server 
and portal.

Note   JasperReports libraries used at report generation time are standard with BPM.

1 Decide whether the report is common or application-specific. 

Common reports can access all BPM data, but application reports retrieve only data for a 
single BPM application.

2 To deploy your JasperReports as a Common Report in BPM, copy your report source file 
(*.jrxml) to BM8.0/webapps/deploy/sbm.war/ebmsapps/common/reports/. 
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To deploy your JasperReports as an application-specific report in BPM, copy your report 
source file (*.jrxml) to BM8.0/webapps/deploy/sbm.war/ebmsapps/<application 
name>/reports/.

Note   Create the reports/ directory within the application directory if not already present. 

3 Copy all images, icons, and other graphical files used on the report to 
BM8.0/webapps/deploy/sbm.war/WEB-INF/classes/

4 Add BM8.0/webapps/deploy/sbm.war/WEB-INF/classes/ to the BPM portal 
classpath.

Note   Make sure that you accomplish this step, so that JasperReports can retrieve the resource 
files placed in this location at run time. 

5 Ensure that all users who are to run the report have correct permissions specified in BPM 
Portal. Take the following steps:

a Log in as an administrator user.

b Go to the Administration|User Management|Users page.

c Enter the userid who is to run reports into the User Name field and Click Go.

d Select the userid displayed in the user line to display the user page.

e Enter the administrator password in the Admin Password field.

f Go to the Permissions tab and check the Default Report permission box.

g Go to the Portal Configuration tab, and select the Report check box, and click Save.

6 Configure settings for temporary file cleanup in the bpmportal.conf file.
bpmportal.jasper.schedule.cleanup.start
bpmportal.jasper.schedule.cleanup.interval
bpmportal.jasper.schedule.cleanup.startdelay
bpmportal.jasper.schedule.cleanup.cutoff
bpmportal.jasper.schedule.cleanup.timeout
bpmportal.jasper.schedule.cleanup.maxfilesize

Running Reports

After you deploy the report, you can run it from and display it in BPM Portal. Complete the 
following steps:

1 Log in to BPM Portal.

2 Go to the Management|Reports|My Reports page.

3 Select a desired report and view format, defaulting to HTML.
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Fig. 2.27
Running the Report

4 Click View to display the report.

Fig. 2.28
Viewing the Report Page 1
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Fig. 2.29
Viewing the Report Page 2

Working with Instances on the Management Tab

On the Management tab, Instance Manager|Instances also enables you to search for and view a list 
of process instances, and change process instance properties for the selected application.

Searching for Process Instances

From the Instances page, you can search for all process instances for a particular BizLogic 
application label. But you cannot search for instances for more than one application at a time, 
because this page does not provide any other filter criteria except Application. 

To search process instances under a particular BizLogic application:

1 On the Management tab, click Instance Manager|Instances to display the Search Instances 
page. 

2 Select an application from the Application drop-down list at the top of the Search Instances 
page. To further define your search on a specific attribute, select the Attributes option, and 
click Go.
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3 Click the Search Criteria tab, and enter relevant data in the Instance Name, Creator, Priority, 
Start Date, and Due Date boxes.

a In the Instance Name box, enter the name of the Instance that you want to retrieve. 

The search engine is case-sensitive. By default, an asterisk (*) is entered for you to view 
all instances. 

b In the Creator box, enter the name of the Creator that you want to retrieve in the text box. 
Alternatively, click the Edit Creator icon to open the Search Users page.

The search engine is case-sensitive. By default, an asterisk (*) is entered for you to view 
all creators. 

c In the Priority box, select an option from the drop-down list. 

The option “All” is selected by default.

d In the Start Date and Due Date boxes, specify a time period from the options in the 
corresponding drop-down list. Alternatively, click the Select Date icon to set the 
respective start date or due date. 

By default, all dates are specified.

4 Click the Display Attributes tab and you can see a list of dataslots. Select the check boxes for 
the dataslots that you want to change.

Note   Dataslots of type Document, Object, and XML are not displayed in the Display 
Attributes tab.

5 Click Search to retrieve all instances that meet the search criteria you have specified.

The search results are presented in the Instance List page as shown in the following figure.

Fig. 2.30
Instance List Page
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You can see two frames on this page. The top frame displays all instances you have selected in step 
3 and dataslots you have selected in step 4. The bottom frame allows you to apply common values 
to selected dataslots. As seen in the top frame, instances are presented in a tabular format, with 
each row representing an instance. Instance name and dataslots are displayed in columns.

If you select no attributes in step 4, you cannot see any dataslots on the Instance List page. It 
displays only the Remove, Remove All, and Cancel options.

Viewing Dataslot Values

After you get the search results of specific process instances, you can view the values of selected 
dataslots. You can view them directly from the dataslot columns in the top frame. Or you can click 
the link in the Instance column to display the selected dataslots in the bottom frame. To view all 
the dataslots of a specific instance, make sure that you have selected all the dataslot types on the 
Display Attributes tab. 

Removing Process Instances

After you get the search results of specific process instances, you can remove the instances by first 
selecting them and then clicking Remove.

Note   This method is the best way to remove process instances whose owner is not the current 
user.

Restarting BizLogic or BizPulse 

You can start or stop BPM servers from the Administration tab. Click Administration to open the 
System Status page and you can see server statuses, as shown in the following figure.

Fig. 2.31
System Status Page

• To stop the BizLogic and BizPulse servers if they are running or suspended, select them and 
then click Stop.

• To start the BizPulse and BizLogic servers, if they are not running, select the corresponding 
check boxes and then click Start. BPM Portal starts the selected servers and updates the 
System Status page.
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Note   Restart BizLogic whenever a managed adapter is modified or removed, or a configuration 
setting is changed. 

Note   It is much easier to restart the servers than to restart the entire JBoss environment. 

Using the Configuration Interface 

You can use the Configuration interface to change log levels for BPM components, and configure 
BizLogic and the email server.

Changing Log Levels 

To change log levels for BPM components, complete the following steps:

1 On the Administration tab, click System|Configuration|Log to display the Log Configuration 
page.

2 Scroll through the listed parameters and modify values as required. 

3 Click Save.

Note   It is useful to set BizLogic Log Level to debug.

Fig. 2.32
Setting BizLogic Log Level to Debug

Configuring BizLogic

You can view configuration parameters for BizLogic in the bizlogic.conf file. This file is in 
the BM 8.0\conf directory. To adjust any of these parameters, either access the bizlogic.conf 
file, or use the configuration interface in BPM Portal. The configuration interface does not display 
all the parameters. To see additional parameters that are not visible in the interface, refer to the 
bizlogic.conf file. 

Using the Configuration interface in BPM Portal to configure the parameters, complete the 
following steps:

1 On the Administration tab, click System|Configuration|BizLogic to display the BizLogic 
Configuration page.

2 Scroll through the listed parameters and modify values that you want to modify.
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3 Click Save.

Note   It is useful to enable BizLogic Server Debug Flag for printing the jst.writeLog in scripts that 
support logging in work step pre-processing or post-processing code. To accomplish it, set 
BizLogic Server Debug Flag for printing the jst.writeLog in scripts to true.

Fig. 2.33
Enabling BizLogic Server Debug Flag for Printing the jst.writeLog in Scripts

Note   If tasks are assigned using email notifications and completed using email reply, make sure 
that you have enabled the email reader. To accomplish it, set Start Email Reader to true.

Fig. 2.34
Enabling Email Reader and Task Notifications

Alternatively, set property bizlogic.email.reader.start to true in the bizlogic.conf file to 
automatically start the email reader when the portal server is started.

You can also use the StartBizLogicAdmin.sh tool in the BM8.0 /bin directory to start or 
stop the email reader immediately, regardless of whether bizlogic.email.reader.start has been set to 
true. 

To stop the email reader, enter the following code:
cd BM8.0/bin
./startBizLogicAdmin.sh
connect ebms ebms
stopEmaillistener 
disconnect
exit

To start the email reader, enter the following code:
cd BM8.0/bin
./startBizLogicAdmin.sh
connect ebms ebms
startEmailListener
disconnect
exit
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Configuring Email Server 

You can view email account information in the sbmemail.properties file. The file is in the 
BM8.0\conf directory. You can access it to adjust any of the parameters.

The following table describes the configuration parameters for the email server, including default 
values if applicable.

Table 2.3  
Email Server Configuration Parameters

Parameter Name Description

bizlogic.email.incoming
.server

Name of mail server where the mailbox of bizlogic.email.id is 
located (for example,mail.qad.com). It is normally different than the 
outgoing mail server.

bizlogic.email.incoming.s
erver.protocol

Protocol used to receive the mails from mail server. Its values could be 
IMAP|IMAPS|POP3|POP3S. This property is optional and if not specified, 
default value is IMAP.

bizlogic.email.incoming.s
erver.port

The default value for this port for protocols: [IMAP-143,IMAPS-
993,POP3-110,POP3S-995]

bizlogic.email.id Email address for BizLogic to send email notifications to users 

bizlogic.email.incoming.s
erver.user

User name to access the mailbox of bizlogic.email.id on mail 
server.

bizlogic.email.incoming.s
erver.password

Password used to access the mailbox of bizlogic.email.id on 
mail server. The password is not clear text; encrypt the password by using 
the command-line utility BM8.0/bin/encrypt.sh.

bizlogic.email.backup.fol
der

Folder on EMail Server to hold the emails after processing. Optional.

bizlogic.email.subject.pa
ttern

A prefix to the subject line in email. You can use it to make the email 
subject pattern more meaningful. 

bizlogic.email.preferred.
template.type

Specifies preferred email template type. Email template type can be either 
plain text (etl) or HTML (htl). This property defaults to etl. 

bizlogic.email.check.inte
rval

E-mail check frequency in milliseconds. Default is 60000 (60 seconds). 

For information about how to create work step-specific email template, see BizLogic Developer 
Guide.

Alternatively, you can configure email server by using BPM Portal. To accomplish it, take the 
following steps:

1 On the Administration tab, click System|Configuration|Email to display the Email Server 
Configuration page.

2 Scroll through the listed parameters and modify values as required. 

Note   If tasks are assigned with email notifications and completed using email reply, make 
sure that you have specified BizLogic Email ID. 
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Fig. 2.35
Setting BizLogic Email ID

3 Click Save.

Viewing Log Files on the Administration Tab

You can use the Log Viewer to track the status and error messages for each component. With the 
Log Viewer, you can see log files for the following:

• BPM Portal

• BizSolo

• BizLogic

• BizPulse

• BizStore

• Archiver

• Event Publisher

• BizRules

Note   These options are available to you only if you have a valid license for the BizRules 
component.

Note   You can adjust the log level for these and other categories on the Log Configuration page.

To access and view log files in the Log Viewer:

1 On the Administration tab, click System|Log Viewer.

2 To view log files for a specific component, select an option from the Log File drop-down list. 
To specify the number of lines that each page contains, enter a number in the Number of Lines 
box. 

3 Click Go. 

Note   Typically, you view log files after work steps are suspended to troubleshoot issues.

Note   The BizLogic log is the most useful log.
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Defining Business Calendars

Administrators can define business calendars using Business Calendar and assign them to specific 
users or groups.

To define a business calendar, complete the following steps:

1 On the Administration tab, click System|Calendars to display the Calendar list page, which 
lists all the information about each of the existing business calendars.

2 Click Add Calendar in the Calendar list page.

The Add Calendar page, which contains General, Working Time, and Non-working Time 
sections, is displayed, enabling you to enter the new business calendar information. An 
example of this page is shown in the following figure.

Fig. 2.36
Add Calendar Page

3 In the General section, enter relevant data, according to the following explanations:

a Specify a name and description for the business calendar in the Name and Description 
boxes.

Note   You cannot use the following special characters in the name or description while 
defining a calendar: < >‘%;+ \|“

b From the Time Zone drop-down list, select the geographical time zone for the business 
calendar.

c Define the Year Range for the business calendar by selecting the start and end years from 
the From and To drop-down lists.

d Define the Regular Business Hours by specifying the start and end times using the Start 
Time and End Time drop-down lists.

e Define the Mid-Day Break by specifying the start and end times using the Start Time and 
End Time drop-down lists.

Note   Name, Description, and Time Zone are the required fields.
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4 Open the Working Time section to define Working Time.

You can define working time if you want to specify business hours different than the regular 
business hours defined in the General section.

5 Open the Non-working Time section to define non-working time.

If you want to specify a holiday or weekend, you can define it in the Non-working Time 
section.

6 Click Save and go back to the previous page.

To reset the form and remove the information you just entered, click Reset.To cancel the action 
and exit the current page, click Cancel.

Setting or Unsetting a Default Calendar

Once you have defined a business calendar or different business calendars, you can specify a 
particular business calendar as the default calendar. BPM uses the default calendar for due date 
calculations when no business calendar is assigned to the user or the group. 

To set a default calendar:

1 On the Administration tab, click System|Calendars to display the Calendar list page.

2 Click the option in the Default Selection column for the calendar that you want to set as a 
default calendar. 

Fig. 2.37
Setting a Default Calendar

3 Click Save. 

Note   Task notification email service requires a calendar of each subscriber. If the default calendar 
is not set and the subscriber has not been explicitly assigned a calendar, then an error will be 
encountered. 

Once you select a default calendar, if needed, you can deselect it so that you have no default 
calendar.
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To unset a default calendar:

1 On the Administration tab, click System|Calendars to display the Calendar list page.

2 Click the No Calendar option in the Default Selection column. 

3 Click Save.

Managing Users on the Administration Tab

You can search for all users and maintain user properties specific to BPM from Users on the 
administration tab. Also you can use the tab to grant BPM data access permissions and portal 
usage permissions to selected QAD users. 

Searching for Users

To search for users:

1 Click Administration|User Management|Users to display the Users list page. 

By default, the Users list page does not display any users. See Figure 2.38.

Fig. 2.38
Users List Page
 

2 To display the list of users, do one of the following:

• If you want to view the list of all users, click All in the Quick Search. 

• If you want to display specified users, specify the user name in the User Name box. If you 
specify the group name, it searches for the users in that group, otherwise it searches in all 
groups. Then click Go.
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Fig. 2.39
Searching for Users

3 You can view the details, group memberships, and the queue memberships of a specific user.

• To view the user details, click the user name hyperlink in the User Name column to display the 
User Detail page. 

• To view the group memberships of the user, click the View hyperlink in the Group 
Memberships column. You can see a list of QAD groups in which the user is a member with 
respect to the login domain on the Memberships Details page.

Note   This screen is one of the only BPM portal screens that currently uses the logged-in 
QAD domain value.

• To view the queue memberships of the user, click the View hyperlink in the Queue 
Memberships column. You can see the queue name and queue description of queues of which 
the current user is a member.

Note   Searching for all groups is required when you load user data to BPM Studio. 

Maintaining User Properties Specific to BPM

You can use the User Details page to maintain user properties specific to BPM. 

Note   Properties maintained in QAD EA are read-only in the User Details page. 

To update BPM user information:

1 Enter the administrator password in the Admin Password text box. 

If you want to change the user password, enter this password again.

2 In the User Details section, enter or modify the relevant data as necessary. 

Note   You can select a business calendar for the user here.

3 Click Save to save the changes and go back to the previous page.

Click Reset to reset the form and remove the information you just entered.

Click Cancel to cancel the action and exit the current page.
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Managing User Permissions

As an administrator, you can grant or revoke permissions to specific BPM data in BPM Portal to 
selected QAD users.

To manage permissions for a user:

1 In the Users list page, click the user name hyperlink in the User Name column for the users 
you want to update.

2 Click Permissions to go to the Permissions section.

3 Select a component in the Component drop-down list, which includes BizLogic, BizPulse, 
Management, Administration, and dashboard.

4 Select or clear the check box to grant or revoke permission for the selected component.

5 Click Save to save the changes and go back to the previous page.

To reset the form and remove the information you just entered, click Reset.

To cancel the action and exit the current page, click Cancel.

Note   It is important to grant BizLogic permissions for process templates, process instances, and 
dataslots as shown in Figure 2.40 on page 39. For example, the user can modify dataslot values 
only after you grant Default DataSlot permission.

Fig. 2.40
Granting BizLogic Permissions for Process Templates, Process Instance, and Dataslots

Managing Portal Configuration

As an administrator, you can grant or revoke BPM portal usage permissions to selected QAD 
users.

To manage portal configuration for a user:

1 In the Users list page, click the user name hyperlink in the User Name column.

2 Click Portal Configuration to go to the Portal Configuration section.

3 Select or clear the check box to grant or revoke BPM portal usage permissions.
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4 Click Save to save the changes and go back to the previous page.

To reset the form and remove the information you just entered, click Reset.

To cancel the action and exit the current page, click Cancel.

Note   It is important to grant management permissions for Overview, Reports, and Instance 
Manager functions as shown in Figure 2.41. Only after you grant management permission for 
Instance Manager to the user, can the user modify the status of task or process instance.

Fig. 2.41
Granting Permissions for Overview, Reports, and Instance Manager

Managing Groups on the Administration Tab

You can search for all groups and maintain group properties specific to BPM from Groups on the 
administration tab. Also you can use the tab to grant BPM data access permissions and portal 
usage permissions to selected QAD groups.

Searching for Groups

Searching for a group is similar to searching for a user. To search for a group, complete the 
following steps:

1 On the Administration tab, click User Management|Groups to display the Groups list page.

By default, it does not display any groups. 

2 To display the list of groups, do one of the following:

• Click All in the Quick Search bar to view the list of all groups.

• Specify the group name by typing it in the Group Name box, and click Go to display the 
specified group.

3 You can view the details, members, and group memberships of a specific group.

• To view the group details, click the group name hyperlink in the Group Name column to 
display the Group Details page.

• To view the members of the group, click the icon in the Member column. 
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• To view the group memberships of the user, click the View hyperlink in the Group 
Memberships column. You can see a list of QAD groups of which the current group is a 
member with respect to the login domain.

Note   This screen is one of the only BPM portal screens that currently uses the logged-in 
QAD domain value.

Note   In order to load user data into Studio, searching for all groups is a required installation or 
setup step.

Maintaining Group Properties Specific to BPM

You can use the Group Details page to maintain user properties specific to BPM. 

Note   Properties maintained in QAD EA are read-only in the Group Details page. 

To update group information:

1 In the Group Details section, enter or modify the relevant data as necessary.

Note   The group name contains only alphanumeric characters and underscores (_), and it 
starts with an alphabet.

Note   Administrators can select business calendars in this page.

2 Click Save to save the changes and go back to the previous page.

To reset the form and remove the information you just entered, click Reset.

To cancel the action and exit the current page, click Cancel.

Managing Group Permissions

As an administrator, you can grant or revoke permissions to specific BPM data in BPM Portal to 
selected QAD groups.

To manage permissions for a group:

1 In the Groups list page, click the group name hyperlink in the Group Name column for the 
group you want to update.

2 Click Permissions to go to the Permissions section.

3 Select a component in the Component drop-down list, which includes BizLogic, BizPulse, 
Management, Administration, and dashboard.

4 Select or clear the check box to grant or revoke permission for the selected component.

5 Click Save to save the changes and go back to the previous page.

To reset the form and remove the information you just entered, click Reset.

To cancel the action and exit the current page, click Cancel.

Note   It is important to grant BizLogic permissions for process templates, process instances, and 
dataslots.
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Managing Portal Configuration

As an administrator, you can grant or revoke BPM portal usage permissions to selected QAD 
groups.

To manage the portal configuration for a group:

1 In the Groups list page, click the group name hyperlink in the User Name column.

2 Click Portal Configuration to go to the Portal Configuration section.

3 Select or clear the check box to grant or revoke BPM portal usage permissions.

4 Click Save to save the changes and go back to the previous page.

To reset the form and remove the information you just entered, click Reset.

To cancel the action and exit the current page, click Cancel.

Note   It is important to grant management permissions for Overview, Reports, and Instance 
Manager functions.
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Other Administration Tasks 

Launching Processes from Custom Forms (for Authorized Users)     44
After the application developer has defined a process in BPM Studio, you can add a menu entry for 
the application menu to show up in .NET UI.

Changing BizLogic Application Status     44
You can change deployment status of deployed BizLogic applications and versions. 

Migrating BPM Artifacts with Migration Tools     47
You can use appPackager and appDeployer to migrate business processes and Java classes across 
environments. And you can use BizRulesAdmin (bradmin.sh) to migrate BizRules projects and 
table decisions. 

Scripting BPM Artifact Migration     56
You can script the migration of BPM artifacts to make regular migration more easily and energy-
saving.

Using BPM Packaging and Deploying Tool     57
Administrators can use the tool bpm_package.sh to package deployed processes and its dependent 
components in one BPM environment and deploy them to another BPM environment. 
Administrators can also use the tool to package and deploy BPM artifacts other than processes and 
BizRules projects.
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Launching Processes from Custom Forms (for 
Authorized Users)

The system allows users to create a launch screen in QAD .NET UI to launch a process from 
custom forms. To implement this, the application developer defines the process in BPM Studio and 
the administrator adds a menu entry to the plugin-menu.xml file. 

After the application developer has defined a process in BPM Studio, the administrator adds a 
menu entry for the application menu to show up in .NET UI:

1 Open the plugin-menu.xml file under the 
Tomcat/webapps/qadhome/configurations/<SysEnvName>/menus directory.

2 In the plugin-menu.xml file, add a ShellMenuItem entry; specify the menu label in the 
label field and the process name in the value field.

Example   The administrator adds the following code to the plugin-menu.xml file. The menu 
name is Launch Process and the process name is Test Process.

<ShellMenuItem image="browse" key="test" label="Launch Process"> 
   <Command type="QAD.Plugin.Bpm.Command.LaunchProcessCommand,QAD.Plugin.Bpm"> 
      <Parameter type="System.String,mscorlib" name="processTemplateName" value="Test 
Process"/> 
   </Command> 
</ShellMenuItem>

3 Place the modified plugin-menu.xml file under 
Tomcat/webapps/qadhome/configurations/<SysEnvName>/menus, where 
<SysEnvName> is the environment name for the QAD .NET UI login; for example, qadui.

After these actions, users can see the Launch Process menu in QAD .NET UI and use it to launch 
the customized process. 

Note   Only authorized users can see the Launch Process menu and use it. The authorization is 
defined by Security settings in the plugin-menu.xml file. 

In the plugin-menu.xml file, if Security for the Launch Process menu entry is set to bpmadmin, 
then only the administrator can see and use the Launch Process menu.

If the Security setting is blank, then the menu is not restricted to any user.

Changing BizLogic Application Status

Once a user or application developer defines a process template in BPM Studio, you can deploy 
and install the process template in the BizLogic server and load any associated rules into BizPulse.

When you uninstall an application, BPM removes the process template from the BizLogic server 
and unloads the rules from BizPulse.

The Refresh option in the BizLogic applications page helps to refresh the list of installed 
applications. The rest of the options in the page are explained in detail in the following sections.

Note   When deployed directories for uninstalled applications are deleted from the 
BM8.0/ebmsapps/directory, you can no longer see them after you refresh the BizLogic page.
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Installing BizLogic Applications

To install BizLogic applications that are currently uninstalled:

1 On the Administration tab, click Applications|BizLogic to view the BizLogic Applications 
page, which displays all current BizLogic applications.

2 Select Uninstalled from the Status drop-down list and click Go to display only the uninstalled 
applications.

The BizLogic Applications–Uninstalled page contains information on:

• Status. The application status can be: All, Installed, Uninstalled, Suspended, Resumed, 
Published, Unpublished, or Deprecated.

• Process template name, or the name that the developer assigns when defining the process 
template in BPM Studio.

• Label, or the name users see in BPM Portal. The developer defines this name as the Label 
when designing the process template in BPM Studio.

• Rule, indicating whether the application contains rules (Yes) or has none (No). If BizPulse 
is not running, BPM allows you to install or uninstall applications without rules. But if you 
want to install or uninstall applications that contain rules, make sure that BizPulse is 
running.

• Application Name, the name of the application. BPM supports versioning for applications, 
where a new version can be installed on an existing application. For a versioned 
application, this column displays the name of the application of which the current process 
template is a version.

• Description, providing a brief description of the application. If necessary, you can define 
the description as a text link to a longer, more detailed description.

• Migrate ACL. Select this check box if you want to migrate permissions of another 
application with same application name to current application.

3 Select the BizLogic application you want to install from the list by selecting it, and click 
Install.

You select a parent name when you install a new version over an existing version. For 
example, you might install a new template, Hiring-2, over an existing template, Hiring-1.

Note   You cannot install deprecated versions, except by uninstalling them first.

Uninstalling BizLogic Applications

To uninstall BizLogic applications that are currently installed or deprecated:

1 On the Administration tab, click Applications|BizLogic to view the BizLogic Applications 
page, which displays all current BizLogic applications.

2 Select Installed or Deprecated from the Status drop-down list and click Go to display only the 
installed applications or the deprecated applications.

3 Select the BizLogic application you want to uninstall from the list by selecting it, and click 
Uninstall. 
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If you want to remove active process instances before removing the application, select the 
Force Uninstall check box.

Note   Before unistalling, remove or complete all the process instances.

Suspending Applications

You can suspend an application if, for example, you are phasing out an outdated application, 
Hiring1, and installing a new application, Hiring2. By suspending Hiring1, you enable its existing 
process instances to remain for users to complete uninterrupted, while only new process instances 
can be started in Hiring2.

To suspend BizLogic applications that are currently installed:

1 On the Administration tab, click Applications|BizLogic to view the BizLogic Applications 
page, which displays all current BizLogic applications.

2 Select Installed from the Status drop-down list and click Go to display only the installed 
applications.

3 Select the BizLogic application you want to suspend from the list by selecting it, and click 
Suspend. 

Resuming Applications

You can resume a suspended application after, for example, you have changed the template of the 
application.

To resume one or more BizLogic applications that are currently suspended:

1 On the Administration tab, click Applications|BizLogic to view the BizLogic Applications 
page, which displays all current BizLogic applications.

2 Select Suspended from the Status drop-down list and click Go to display only the suspended 
applications.

3 Select the BizLogic application you want to resume from the list by selecting it, and click 
Resume. 

Fig. 3.1
Resuming BizLogic Applications
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Migrating BPM Artifacts with Migration Tools

Sometimes you are prompted to migrate BPM artifacts—business processes, business object 
classes, BizRules decision tables, and other common components—from one QAD BPM 
environment to another. The most important migration scenario is the promotion of new or 
modified business processes from a development environment to a common test environment, or 
from a test to a production environment.

Although you can migrate all BPM artifacts across environments from BPM Studio, it is not 
recommended for the following reasons:

• BPM implementers who have direct access to production environments from their BPM 
Studio installations can easily publish untested or unstable artifacts into production by 
mistake. By using separate administration tools available only to administrators, such errors 
are less likely to occur.

• The responsibilities of software development and system administration ought to be separated 
to provide tighter change management across the IT organization and increase the security of 
the production environment.

Therefore, special migration tools are suggested to migrate BPM artifacts across environments.

Migrating Business Processes and Java Classes

Before walking through the migration process, it is important to understand the following two 
aspects:

• How do you replace one version of a business process with another version of the same 
process?

• How do the new and old versions coexist within the same BPM environment?

When a business process is published from the BPM Studio to a BPM server, the server uses 
several attributes to identify the process and denote its version.

• Application Name, sometimes called Model Name. It identifies the business process across 
all of its versions. In other words, if multiple business processes are published with the same 
Application Name, they are managed as different versions of a single process, rather than 
separate processes.

• Process Template Name. It denotes the version of the business process, distinguishing one 
version of the business process (that is, the BizLogic Application) from others. For new 
business processes, the Process Template Name and Application Name are assigned the same 
value by default in BPM Studio. When new versions of an existing process are created in BPM 
Studio, the Process Template Name defaults to the Application Name with a version suffix.

You can view the versions of a specific application by going to Administration|Application|
BizLogic. Typically, only a single version of each application has the status of Installed, while 
other versions can be Deprecated, Suspended, or Uninstalled. New process instances are always 
created using the installed version, although existing instances that use deprecated or suspended 
versions are still processed normally. The BPM administrator can change the status by installing, 
uninstalling, suspending, or resuming particular versions from the BPM portal.
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When you migrate a new version of a business process to an environment that contains an older 
version, typically you deprecate the existing version and use the new version. In this case, the 
status of the existing version is changed to Deprecated in the target environment, while the new 
version is moved to the status of Installed.

QAD BPM provides two command-line utilities, namely appPackager and appDeployer, to help 
migrate business processes and Java classes across server environments. These utilities are scripts 
written using the Apache Ant tool. Unlike the BizRulesAdmin tool, which accesses the BPM 
repository to export and load projects, appPackager and appDeployer access most of the artifacts 
directly from the BPM directories in the filesystem.

• appPackager packages the specified business processes and other artifacts from the source 
BPM server environment into a ZIP archive.

• appDeployer unpacks and deploys the contents of an archive that appPackager has created 
into a target BPM server environment.

This approach allows BPM artifacts to be migrated server-to-server by system administration 
personnel, avoiding the need for BPM developers to connect their BPM Studio workspaces 
directly to production environments. Thus, it promotes better segregation of duties between 
developers and system administrators. 

Configuring a Packaging File

The appPackager requires a package configuration file, identifying the BPM artifacts to package 
and migrate. QAD provides a set of sample configuration files that you can use to deploy the QAD 
BPM sample processes across environments, but in general the configuration is specific to every 
BPM implementation.

Fig. 3.2
Sample Configuration Files

The following example shows the elements that each XML configuration file contains.
<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE Application SYSTEM 
"file:///${sbm.home}/conf/resources/common/ProcessPackage.dtd">

<Application name="QADAllSamples_SE" filename=
"${sbm.home}/apppackager/QADAllSamples_SE.zip">
  <!-- Item Creation -->
  <Process name ="ItemCreation_SE" parentpt="ItemCreation_SE" type="BizLogic" operation=
"InstallAsVersion">
  </Process>
  <Process name ="ItemCostApproval_SE" parentpt="ItemCostApproval_SE" type="BizLogic" 
operation="InstallAsVersion">
  </Process>
  <Process name ="ItemCostSetup_SE" parentpt="ItemCostSetup_SE" type="BizLogic" operation=
"InstallAsVersion">
  </Process>
  <Process name ="ItemCustomerInfoSetup_SE" parentpt="ItemCustomerInfoSetup_SE" type=
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"BizLogic" operation="InstallAsVersion">
  </Process>
  <Process name ="ItemDefinition_SE" parentpt="ItemDefinition_SE" type="BizLogic" 
operation="InstallAsVersion">
  </Process>

<!-- Common Resources -->
  <Resources>
    <Resource src="../ebmsapps/common/bo/classes/com/qad/bpm/bo" type="dir" target=
"../ebmsapps/common/bo/classes/com/qad/bpm/bo"/>
    <Resource src="../webapps/deploy/sbm.war/WEB-INF/classes/com/qad/bpm/bo" type="dir" 
target="../webapps/deploy/sbm.war/WEB-INF/classes/com/qad/bpm/bo"/>
    <Resource src="../ebmsapps/common/lib/QdocAdapters_SE.jar" type="file" target=
"../ebmsapps/common/lib"/>
    <Resource src="../webapps/deploy/sbm.war/WEB-INF/qadmetadata" type="dir" target=
"../webapps/deploy/sbm.war/WEB-INF/qadmetadata"/>
  </Resources>
</Application>

• Application: The Application element is the top-level element, defining the overall name of 
the package (name) and the location of the ZIP file that it creates (filename).

• Process: There is a Process element for each process template included in the package, 
defining its Process Template Name (name) and Application Name (parentpt). The type is 
always BizLogic, and the operation attribute is normally set to InstallAsVersion. 
When a process that exists in the target BPM environment is deployed with operation 
InstallAsVersion, the new process template is installed as the current version, and the 
previously installed version is deprecated. When InstallAsVersion is used for a process 
that does not yet exist in the target BPM environment, the new process is deployed but its 
status is Uninstalled. In this case, make sure to promote the process to the Installed status from 
the BPM portal. Alternatively, for new processes the operation Reinstall can be used. In 
this case, the process is automatically promoted to Installed status when deployed. Other 
operations less frequently used are RefreshPt.

• Resources: Common resources that are not business processes are specified as individual 
Resource elements under a single Resources element. Resources include the following kinds 
of BPM artifacts:

• Business object classes. Unlike other artifacts, business object classes are deployed into 
two locations, one for the JBoss EJB server and the other for the Portal server.

• QDoc-managed adapter classes, typically packaged in a JAR.

• QAD metadata files that .NET UI uses to support the BPM browses.

Each Resource element specifies the source location of the artifact in the file system, relative 
to the BM 8.0/appPackager/ directory (src), and the target location (target). Typically, 
the values of these attributes are the same. With the type attribute, it is possible to specify 
either a single file (type="file"), or a directory containing multiple files (type="dir").

Make sure to place the configuration file in the directory BM8.0/appPackager/ in the source 
BPM environment.

Running AppPackager

Once you have created the packaging configuration file, create an archive file for it as follows.

1 Go to the BM8.0/apppackager/ directory.

2 Run the command:
../bin/appPackager.sh <path to package config file>
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There is no need to provide the name of the archive to write, because it is specified in the 
configuration file.

After the archive has been created in the BM8.0/apppackager/ directory, copy or transfer it to 
the BM8.0/apppackager/ directory in the target BPM environment.

Running AppDeployer

In the target BPM environment, complete the following steps:

1 Make sure that the JBoss EJB and Portal servers in the target BPM environment are running, 
because the appDeployer tool communicates with the Portal server to deploy some of the 
artifacts.

2 Open BM8.0/ant/ant.properties in a text editor, and check the value of the sbmUrl 
property. If it does not reference the correct URL for the BPM portal, modify it and save the 
file.

3 Save the package archive copied from the source environment into the 
BM8.0/apppackager/ directory.

4 Go to the BM8.0/apppackager/ directory.

5 Run the command:
../bin/appDeployer.sh <path to package archive> 

Do not reference the package configuration file, because it is contained inside the archive.

6 Verify that the contents of the archive were copied into the designated locations.

7 If the deployed artifacts include Java classes such as business objects or QDoc adapters, restart 
the JBoss servers. If no Java classes were included, a restart is not necessary.

8 Log in to the BPM portal as a BPM Administrator.

9 Go to Administration|Applications|BizLogic. Verify that the process templates from the 
archive were installed.

Any process template from the packaging archive that has the following characteristics is deployed 
with the Uninstalled status:

• It was configured for deployment in the packaging configuration file with operation 
InstallAsVersion.

• It is associated with a new BizLogic application that has no versions deployed on the target 
BPM server. In other words, the value of its parentPt attribute (Application Name) is 
different from the Application Names of all other deployed processes.

To promote a process template that was deployed in Uninstalled status to the Installed status, 
check the box on its line and click Install at the bottom of the page.

Migrating BizRules Projects and Decision Tables

Before going through the migration process, it is important to understand the versioning of 
BizRules Decision Table.
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The versioning of business rules and decision tables implemented in BizRules projects are 
different from the versioning of business processes and other BPM artifacts. Unlike business 
processes, which are launched and can be updated from business events that originate outside of 
BPM, BizRules decision tables are referenced only from within business processes. When a 
BizRules decision table is used inside a business process work step, the name and version of its 
BizRules project are referenced only within that work step. In short, the business process version 
being used completely determines the BizRules decision table version that is used. Decision table 
versions are easier to control than process versions. The reason is that even if an incorrect 
BizRules project version is deployed into a BPM environment, its decision table can never be used 
until some business process references it directly. Therefore, the versions of business rules and 
decision tables are determined at the project level, rather than by individual decision table. 

The system accesses BizRules objects during run time through the built-in BPM repository in 
BPM Portal. So, to make a BizRule project accessible inside an environment or even referenced 
from a business process work step, the first step is to deploy a BizRules project to the BPM 
repository. For this reason, the packaging and deployment utilities used for business process 
migration are not suitable for BizRules. A separate BizRulesAdmin tool (bradmin.sh) is 
available to export and import BizRules project contents from and to the BPM repository. 

Exporting a BizRules Project 

To export a BizRules project from a source BPM environment using bradmin.sh, use the 
following procedures:

1 Go to the BM8.0/bin/ directory.

2 Run bradmin.sh from the command line, logging in as a BPM administrator.

3 From the BizRules Admin menu displayed on the console, select 1) Project Admin.

4 From the Project Admin menu, select 1) List All Projects. The output shows the ID 
numbers and names of all BizRules projects in the BPM environment, one of which is 
referenced in the next step.

5 From the Project Admin menu, select 4) Enter Project Mode. When prompted, enter the 
ID or name of the project to export from the list displayed in Step 4.

6 From the Project Mode: <project name> menu, select 4) Checkout Project. bradmin.sh 
displays messages that the project folders have been placed into the BM8.0/ruleapps/ 
directory.

7 Select 9) Exit from the menu, then select the Exit option from all the higher-level 
bradmin.sh menus until the session terminates.

8 Go to the BM8.0/ruleapps/ directory, confirming that the exported BizRules project is 
stored there.

After you have exported the BizRules project, copy the directory in BM8.0/ruleapps/ 
containing the BizRules project to the BM8.0/ruleapps/ directory in the target environment.

Figure 3.3 on page 52 is a sample bradmin.sh session illustrating the exporting procedures. 
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Fig. 3.3
Sample bradmin.sh Session–Exporting a BizRules Project
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Importing a BizRules Project 

To import a BizRules project into a target BPM environment using bradmin.sh after you have 
exported it from the source BPM environment, complete the following procedure:

1 Verify that the BizRules project folder has been exported from a source BPM environment and 
copied into the BPM8.0/ruleapps/ directory.

2 Go to the BM8.0/bin/ directory.

3 Run bradmin.sh from the command line, logging in as a BPM administrator.

4 From the BizRules Admin menu displayed on the console, select 1) Project Admin.

5 From the Project Admin menu, select 1) List All Projects. The output shows the names 
of all BizRules projects currently in the BPM environment.

• If the project being imported does not exist in the BPM environment, you are required to 
create it first. In this case, select 2) Create Project from the Project Admin menu. Enter 
the name of the BizRules project to import. Make sure that the name is the same as the name 
of the top-level folder inside BM8.0/ruleapps/ where the project files are stored.

• If the project exists in the BPM environment, select 4) Enter Project Mode from the 
Project Admin menu. Enter the ID or name of the BizRules project. Select 3) Update 
Project from the Project Mode: <project name> menu to update the decision tables within 
the project.

6 After you have either created or updated a BizRules project, bradmin.sh displays a message 
confirming that the decision tables contained in the project have been loaded.

7 Select 9) Exit from the menu. Select the Exit option from all the higher-level bradmin.sh 
menus until the bradmin.sh session terminates.

Figure 3.4 on page 54 is a sample bradmin.sh session illustrating the importing procedures to 
update an existing BizRules project ItemSelectRules_SE_V1.
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Fig. 3.4
Sample bradmin.sh Session–Importing a BizRules Project
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Deleting an Existing Decision Table 

To delete a decision table from a BizRules project in the target BPM environment, no import is 
required. Instead, the obsoleted decision table is deleted directly from the environment while 
inside a bradmin.sh session. 

1 Go to the BM8.0/bin/ directory.

2 Run bradmin.sh from the command line, logging in as a BPM administrator.

3 From the BizRules Admin menu displayed on the console, select 1) Project Admin.

4 From the Project Admin menu, select 1) List All Projects. The output shows the names 
of all BizRules projects currently in the BPM environment.

5 From the Project Admin menu, select 4) Enter Project Mode. Enter the name of the 
BizRules project containing the decision table that you want to delete taken from the list in 
step 4.

6 From the Project Mode: <project name> menu, select 2) List All Rulesets to obtain a 
list of the decision tables in the project.

7 From the Project Mode: <project name> menu, select 6) Delete Ruleset. Enter the ID or 
name of the decision table or ruleset that you want to delete when prompted, using the 
information from the ruleset list. bradmin.sh displays a message confirming the deletion.

8 Select 9) Exit from the menu, and then select the Exit option from all the higher-level 
bradmin.sh menus until the bradmin.sh session terminates.

Checking Decision Tables Using the BPM Portal

After you have imported BizRules projects and decision tables into a target BPM environment, 
you cannot validate the results by reviewing the contents of the BPM directories in the file system. 
Rather, you are required to review the contents of the BizRules repository under the support of the 
BPM portal on-line. The procedure for reviewing the contents is as follows.

1 Log in to the BPM portal as a BPM administrator.

2 Click the BRMS Portal link in the upper-right corner of the page to go to BRMS Portal.

Fig. 3.5
Clicking BRMS Portal

3 You can see all the BizRules projects currently in the BPM environment on the Projects Info 
tab. In the Navigate pane on the left, select and expand the node for the BizRules project 
previously imported.
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Fig. 3.6
Viewing BizRules Projects

4 Double-click the Business Rules Assets node under the selected project to open a tab that lists 
all decision tables inside the project.

Fig. 3.7
Viewing BizRules Projects

5 Double-click the decision table that you want to review to inspect its contents and confirm that 
expected changes were successfully migrated.

6 After you finish the review, log out of the BPM portal.

Scripting BPM Artifact Migration

A common question asked during QAD BPM implementations is how to script the migration of 
business processes and other BPM artifacts across BPM environments. The most common scripted 
scenario is the scheduled promotion of artifacts from a development to a common test 
environment, and from a test to a production environment. The use of scripts allows migration to 
be executed regularly with reduced manual effort and less opportunity for error. Because both sets 
of migration tools, appPackager and appDeployer, and BizRulesAdmin, are command-line 
utilities, invoking them from shell scripts is feasible.
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Scripting appPackager and appDeployer 

As long as the packaging configuration files that appPackager and appDeployer use can be 
prepared before each migration, the scripts necessary to run the appPackager and appDeployer 
tools are straightforward. These utilities are non-interactive, and can be run with run-time 
arguments directly referencing the prepared configuration files. To make the creation of packaging 
configuration files easier, it is recommended that one or more templates for the configuration files 
be created in advance. Then a designated BPM developer or administrator can clone the templates 
to reference the correct processes and versions for each specific migration, before running the 
script.

Scripting BizRulesAdmin 

Scripting for BizRulesAdmin is more complex, as bradmin.sh is interactive, prompting the user 
for input at each step. Nevertheless, standard responses to the prompts to match particular 
migration scenarios can be placed into input files and validated through careful bradmin.sh 
testing. The bradmin.sh migration scripts use different input sequences for exporting and 
importing different kinds of changes. Although some manual decisions are required to determine 
which predefined inputs are appropriate for each case, this approach can at least reduce the manual 
input required to migrate BizRules decision tables.

Using BPM Packaging and Deploying Tool

The appPackager utility only packages artifacts that are deployed physically to the BPM 
environment. Projects and metadata that are exported to the BPM repository are not packaged. To 
package these artifacts in the BPM repository, you need the tool bpm_package.sh.

Administrators can use bpm_package.sh to package deployed processes and its dependent 
components (like business objects, adapters, dataslots, and messages) in one BPM environment 
and deploy them to another BPM environment. 

About Package Descriptor

In order to use bpm_package.sh, you are required to create a package descriptor, which is an 
XML file containing the details of what artifacts to package, install, and deploy. The file is 
packaged along with the actual package content. 

Here is an example of the BPM package descriptor:
<?xml version="1.0" encoding="UTF-8" ?>
<QAD>
  <QADVersion>QADEE</QADVersion>
  <Application>Customer_EE</Application>
  <BPM>
    <Projects>
      <Project name="CustomerCreation_EE" type="BizLogic">
        <Processes>

<Process applicationName="CustomerCreation_EE"
 templateName= "CustomerCreation_EE"/>
<Process applicationName="CustomerCreationSelect_EE" templateName=
"CustomerCreationSelect_EE"  />
<Process applicationName="CustomerEndUserSetup_EE" templateName=
"CustomerEndUserSetup_EE" />
<Process applicationName="CustomerOperationalSetup_EE" templateName=
"CustomerOperationalSetup_EE" />
<Process applicationName="EndUserOperationalSetup_EE" templateName=
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"EndUserOperationalSetup_EE" />
        </Processes>
      </Project>
      <Project name="CustomerSelectRules_EE_V1" type="BizRules">
      </Project>
      <Project name="BusinessObjects_EE" type="CommonResources">
        <BusinessObjects>
          <Category name="qadbpm" package="com.qad.bpm.bo">
            <BusinessObject name="Debtor_EE_1" />
          </Category>
        </BusinessObjects>
      </Project>
      <Project name="QdocAdapters_EE" type="CommonResources">
        <Adapters>
          <Category name="QdocAdapters">

<Adapter name="MaintainDebtorCreditHoldAdapter" class=
"com.qad.bpm.adapters.qdocadapters_ee.MaintainDebtorCreditHoldAdapter"/>

          </Category>
        </Adapters>
      </Project>
    </Projects>
    <Messages>
      <Message name="QdocEventAcknowledgement" />
      <Message name="QdocEventAcknowledgements" />
      <Message name="SendTasksNotificationEmails" />
    </Messages>
    <Dataslots>

<Category name="User">
      <Dataslot name="baseApprovalSubprocessCount" />
      <Dataslot name="disallowDelete" />
      <Dataslot name="disallowUpdate" />
      <Dataslot name="documentId1" />
      <Dataslot name="documentId2" />
      <Dataslot name="documentRejected" />
      <Dataslot name="domain" />
      <Dataslot name="emailFromAddress" />
      <Dataslot name="entity" />
      <Dataslot name="oidFields" />
      <Dataslot name="primaryBoDataslotNames" />
      <Dataslot name="qadNSMap" />
      <Dataslot name="qdocExceptions" />
      <Dataslot name="qdocResult" />
      <Dataslot name="sharedDomains" />
      <Dataslot name="site" />
      <Dataslot name="sourceApplication" />
      <Dataslot name="stakeholderEmails" />
      <Dataslot name="stakeholderUsersOrEmails" />
      <Dataslot name="subProcessInstanceName" />
      <Dataslot name="subProcessTemplateName" />

</Category>
    </Dataslots>
  </BPM>
</QAD>

Creating BPM Package

The bpm_package.sh tool is under /qadapps/SBM/scripts. Its general syntax is as follows:
bpm_package.sh ACTION [OPTIONS]

Before you create the package, first manually export projects and all metadata to the BPM 
repository. Repository locations for BPM artifacts are as follows:

• Process Project (BizLogic): Repository/Projects/BPM/<Project Name>

• BizRules Project: Repository/Projects/BizRules/<Project Name>

• CommonResources Project: Repository/Projects/Common Resources /<Project 
Name>
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• Adapter: Repository/Managed Adapters/<Category>/<Adapter Name>

• Business Object: Repository/Business Objects/<Category>/<Business Object 
Name>

• Message: in database; you can see it from the Studio

• Dataslots: Repository/Dataslots/<Category>/<Dataslot Name>

1 Use the following command to generate a package descriptor template:
bpm_package.sh -generate-descriptor [-descriptor <BPM Package Descriptor XML>] [-
application <Application Name>]

The following table shows the use of parameters for generating the descriptor. 

Table 3.1  
bpm_package.sh Parameters for Generating the Descriptor

Parameter Use

-descriptor <BPM Package 
Descriptor XML>

You can specify the name of the package descriptor template that you 
want to generate.

-application <Application Name> You can specify the name of the application that you want to package.

Example   bpm_package.sh -generate-descriptor -descriptor 
<MyPackageDescriptor.xml>

Example   bpm_package.sh -generate-descriptor -application 
<CustomerCreation>

The name of the generated descriptor file name is determined in the following order:

• Descriptor file name specified in command-line argument

• Application Name specified in command-line argument

• bpm_package.xml

• If the file name is relative path, starting from current working directory

The output directory of the generated descriptor is determined in the following order:

• The path in the specified descriptor command-line argument

• Current working directory

Note   Although the generated descriptor includes QXtend artifacts, QXtend artifacts are not 
supported in the BPM 1.3 release. Ignore or remove them from the descriptor.

2 Modify the package descriptor template generated in step 1 to include the artifacts you want 
for the package.

3 (Optional) Use the following command to validate the package descriptor:
bpm_package.sh -validate-descriptor [-descriptor <BPM Package Descriptor XML>]

Example   bpm_package.sh -validate-descriptor -descriptor 
<MyPackageDescriptor.xml>

Example   bpm_package.sh -validate-descriptor -descriptor 
<CustomerCreation.xml>

4 Use the following command to create the package:
bpm_package.sh -export -descriptor <BPM Package Descriptor XML> [-output-dir <Output 
Directory>]

The following table shows the use of parameters for creating the package.
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Table 3.2  
bpm_package.sh Parameters for Creating the Package

Parameter Use

-descriptor <BPM Package 
Descriptor XML>

You can specify the name of the package descriptor template that you 
want to generate

-output-dir <Output Directory> You can specify the directory for the output of the result package file

The name of the resulting package file is <Application_Name>.zip, where 
Application_Name is extracted from element Application in the package descriptor. The 
output directory is where the result package is created. The default value is the current 
working directory.

Note   If the specified artifact does not exist, an error message is displayed. 

Installing or Deploying BPM Package

After you have created the package, you can install or deploy processes from it to another 
environment, so that you can make them available for customization or for production. 

• Install: Import everything in the package to the BPM repository to make it available for 
customization. In this case,

• All projects are exported as projects to the repository, including BizLogic (BPM) projects, 
BizRules projects, and Common Resources projects.

• All metadata is exported to the repository, including Process Template Model, Business 
Object, Adapter, Dataslot.

• Deploy: Deploy everything to the BPM server to make it ready for launching. In this case, the 
following artifacts are deployed to the BPM server:

• Process Template

• BizRules

• Business Object

• Adapter

• Message

To install the package, run the following command line on the target BPM host:
bpm_package.sh -import install -package <BPM Package Zip>

To deploy the package, run the following command line on the target BPM host:
bpm_package.sh -import deploy -package <BPM Package Zip>

Note   If install or deploy is not specified, the package is installed and deployed. If install 
is specified, the package is only installed. If deploy is specified, the package is only deployed.

The system deploys the process templates according to the operation specified in the package 
descriptor. There are three operation options: 

• Reinstall: Existing process instances are removed, and the process template is updated.

• RefreshPt: The template is refreshed in memory. Existing and new process instances are 
affected, and Chart View uses a new diagram.
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• InstallAsVersion: If the application is the same, a new version is created, but the template 
name is different. New process instances are created based on the new version. If application 
and template name are the same, it affects neither existing instances nor new instances, but 
Chart View uses a new diagram.

For a production environment where existing process instances cannot be affected, apply 
InstallAsVersion to have a new Process Template version for the same application. The new 
Process Template version has the same application name but a different process template name.

For development environment, you can use Reinstall to clean up all existing instances.

Note   Make sure that the deploy script specifies operations for deploying. If operation is not 
specified in the descriptor, by default, InstallAsVersion is applied. 

The deployment locations for BPM artifacts are as follows:

• BizRules: BM8.0/ruleapps/<BizRules Name> and in database

• Adapter jar: BM8.0/ebmsapps/common/lib/<Project Name>.jar

• Business Object class: 

• BM8.0/ebmsapps/common/bo/classes/<BO Package Path>/<BO Name>.class

• BM8.0/webapps/deploy/sbm.war/WEB-INF/classes/<BO Package Path>/<BO 
Name>.class

• Other common resource files: location defined in the descriptor

Note   The installation process only checks the availability of the top level business object. If child 
business objects are not specified in the descriptor, the installation process does not check them. 
So for child business objects, it is necessary for you to check all business objects manually to 
include all child business objects if there are any. For example, Business Object 
SaleOrderDetails_EE_1 is a child business object for SalesOrder_EE_1 in SalesOrder process; in 
this case, make sure to include Business Object SaleOrderDetails_EE_1 in the descriptor.

Example: Packaging, Installing, and Deploying BPM Processes

You want to package some business processes from one BPM environment, and install and deploy 
them to another BPM environment. You want the package to include processes of 
CustomerCreation_EE, CustomerCreationSelect_EE, CustomerEndUserSetup_EE, 
CustomerOperationalSetup_EE, and EndUserOperationalSetup_EE. 

To complete the packaging, installation, and deployment, use the following procedures:

1 Manually export the following projects and metadata to the BPM repository:

• Process projects, including CustomerCreation_EE, CustomerCreationSelect_EE, 
CustomerEndUserSetup_EE, CustomerOperationalSetup_EE, and 
EndUserOperationalSetup_EE 

• BizRules project: CustomerSelectRules_EE_V1

• Business Objects

• QDoc Adapters 

• Messages

• Dataslots
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2 On the BPM host, run the following command to generate the package descriptor template:
bpm_package.sh -generate-descriptor -descriptor Customer_EE.xml

3 Modify the Customer_EE.xml descriptor to include the business processes that you want for 
the package:
<?xml version="1.0" encoding="UTF-8" ?>
<QAD>
  <QADVersion>QADEE</QADVersion>
  <Application>Customer_EE</Application>
  <BPM>
    <Projects>
      <Project name="CustomerCreation_EE" type="BizLogic">
        <Processes>

<Process applicationName="CustomerCreation_EE"
 templateName= "CustomerCreation_EE"/>
<Process applicationName="CustomerCreationSelect_EE" templateName=
"CustomerCreationSelect_EE"  />
<Process applicationName="CustomerEndUserSetup_EE" templateName=
"CustomerEndUserSetup_EE" />
<Process applicationName="CustomerOperationalSetup_EE" templateName=
"CustomerOperationalSetup_EE" />
<Process applicationName="EndUserOperationalSetup_EE" templateName=
"EndUserOperationalSetup_EE" />

        </Processes>
      </Project>
      <Project name="CustomerSelectRules_EE_V1" type="BizRules">
      </Project>
      <Project name="BusinessObjects_EE" type="CommonResources">
        <BusinessObjects>
          <Category name="qadbpm" package="com.qad.bpm.bo">
            <BusinessObject name="Debtor_EE_1" />
          </Category>
        </BusinessObjects>
      </Project>
      <Project name="QdocAdapters_EE" type="CommonResources">
        <Adapters>
          <Category name="QdocAdapters">

<Adapter name="MaintainDebtorCreditHoldAdapter" class=
"com.qad.bpm.adapters.qdocadapters_ee.MaintainDebtorCreditHoldAdapter"/>

          </Category>
        </Adapters>
      </Project>
    </Projects>
    <Messages>
      <Message name="QdocEventAcknowledgement" />
      <Message name="QdocEventAcknowledgements" />
      <Message name="SendTasksNotificationEmails" />
    </Messages>
    <Dataslots>

<Category name="User">
      <Dataslot name="baseApprovalSubprocessCount" />
      <Dataslot name="disallowDelete" />
      <Dataslot name="disallowUpdate" />
      <Dataslot name="documentId1" />
      <Dataslot name="documentId2" />
      <Dataslot name="documentRejected" />
      <Dataslot name="domain" />
      <Dataslot name="emailFromAddress" />
      <Dataslot name="entity" />
      <Dataslot name="oidFields" />
      <Dataslot name="primaryBoDataslotNames" />
      <Dataslot name="qadNSMap" />
      <Dataslot name="qdocExceptions" />
      <Dataslot name="qdocResult" />
      <Dataslot name="sharedDomains" />
      <Dataslot name="site" />
      <Dataslot name="sourceApplication" />
      <Dataslot name="stakeholderEmails" />
      <Dataslot name="stakeholderUsersOrEmails" />
      <Dataslot name="subProcessInstanceName" />
                                          



Other Administration Tasks      63
      <Dataslot name="subProcessTemplateName" />
</Category>

    </Dataslots>
  </BPM>
</QAD>

Note   Make sure that you have exported all artifacts defined in the descriptor to the BPM 
repository.

4 (Optional) Use the command to validate the Customer_EE.xml descriptor:
bpm_package.sh -validate-descriptor -descriptor Customer_EE.xml

5 Use the command to create the package:
bpm_package.sh -export -descriptor Customer_EE.xml

The resulting package file name is Customer_EE.zip. The output directory is the current 
working directory.

6 On the target BPM host, use the command to deploy the package:
bpm_package.sh -import -package Customer_EE.zip

Then you can see the BPM artifacts in the deployment locations:

• Process Template: 

• BM8.0/ebmsapps/CustomerCreation_EE

• BM8.0/ebmsapps/CustomerCreationSelect_EE

• BM8.0/ebmsapps/CustomerEndUserSetup_EE

• BM8.0/ebmsapps/CustomerOperationalSetup_EE

• BM8.0/ebmsapps/EndUserOperationalSetup_EE

• BizRules: BM8.0/ruleapps/CustomerSelectRules_EE_V1 and in database

• Adapter jar: BM8.0/ebmsapps/common/lib/QdocAdapters_EE.jar

• Business Object class: 

• BM8.0/ebmsapps/common/bo/classes/com/Debtor_EE_1.class

• BM8.0/webapps/deploy/sbm.war/WEB-
INF/classes/com/Debtor_EE_1.class

You can also see the BPM artifacts in the repository:

• Process projects (BizLogic) in Repository/Projects/BPM/Customer_EE

• BizRules project in Repository/Projects/BizRules

• Adapters in Repository/QdocAdapters_EE/Adapters/QdocAdapters

• Business Object in Repository/BusinessObjects_EE/Business Objects/User

• Messages in database; you can see them from the Studio

• Dataslots in Repository/Dataslots/User
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